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Preface

NOTICE TO CUSTOMERS

document.

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXA”, where “XXXXX" is the document number and “A” is the revision level of the

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help.
Select the Help menu, and then Topics to open a list of available on-line help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
MCP3421 SOT23-6 Evaluation Board. Items discussed in this chapter include:

Document Layout

Conventions Used in this Guide
Recommended Reading

The Microchip Web Site
Customer Support

Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MCP3421 SOT23-6 Evaluation Board as a
development tool to emulate and debug firmware on a target board. The manual layout
is as follows:

Chapter 1. “Quick Start Instructions” — this chapter provides an overview of the
MCP3421 SOT23-6 Evaluation Board and instructions on how to obtain the ADC
conversion results using the PICKit Serial Analyzer.

Appendix A. “Schematic and Layouts” — shows the schematic and layout
diagrams for the MCP3421 SOT23-6 Evaluation Board.

Appendix B. “Bill Of Materials (BOM)” — lists the parts used to build the
MCP3421 SOT23-6 Evaluation Board.

© 2009 Microchip Technology Inc. DS51793A-page 1
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description

Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB® IDE User’s Guide

Emphasized text

...Is the only compiler...

dialog

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”

Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

A tab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, R is the radix and n is a
digit.

4'b0010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat

File paths c:\mccl1l8\h

Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants OXFF, “A”

Italic Courier New

A variable argument

file.o, where File can be
any valid filename

Square brackets [ ]

Optional arguments

mccl8 [options] file
[options]

Curly brackets and pipe
character: { |}

Choice of mutually exclusive
arguments; an OR selection

errorlevel {0]1}

Ellipses...

Replaces repeated text

var_name [,
var_name...]

Represents code supplied by
user

void main (void)
{ ...
}

DS51793A-page 2
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RECOMMENDED READING

This user's guide describes how to use the MCP3421 SOT23-6 Evaluation Board with
the PICKit Serial Analyzer. The following Microchip documents are available and rec-
ommended as supplemental reference resources.

PICKit™ Serial Analyzer User’s Guide, DS51647

Consult this document for instructions on how to use the PICkit Serial Analyzer hardware
and software.

MCP3421 Data Sheet, “18-Bit Analog-to-Digital Converter with I°C Interface and
On-Board Reference”, DS22003

This data sheet provides detailed information regarding the MCP3421 product.

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the web site contains the following
information:

« Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

» General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

» Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

« Distributor or Representative

 Local Sales Office

* Field Application Engineer (FAE)

» Technical Support

Customers should contact their distributor, representative or field application engineer

(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com

© 2009 Microchip Technology Inc. DS51793A-page 3
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DOCUMENT REVISION HISTORY
Revision A (January 2009)

« |nitial Release of this Document.

DS51793A-page 4 © 2009 Microchip Technology Inc.



MCP3421 SOT23-6 EVALUATION
MICROCHIP BOARD USER'S GUIDE

Chapter 1. Quick Start Instructions

1.1 INTRODUCTION

The following sections provide an overview of the MCP3421 SOT23-6 Evaluation
Board and demonstrate how to use it with the PICkit™ Serial Analyzer
(P/N: DV164122).

The following topics are covered:

 Description of the MCP3421 SOT23-6 Evaluation Board

« Using MCP3421 SOT23-6 Evaluation Board with the PICKit Serial Analyzer to
evaluate the MCP3421 device

1.2 DESCRIPTION OF THE MCP3421 SOT23-6 EVALUATION BOARD

The MCP3421 SOT23-6 Evaluation Board (P/N MCP3421EV) contains a MCP3421
18-hit Delta-Sigma Analog-to-Digital Converter (ADC). The MCP3421 is an 18-bit
single channel ADC device with various options. The MCP3421 SOT23-6 Evaluation
Board has analog input connection pads and Vpp, SDA, and SCL test pads. The user
can connect any sensor input signal to this evaluation board and test the ADC
conversion results. The PICkit Serial Analyzer’s PC graphic user interface (GUI)
provides the user’s interface for writing configuration register bits of the MCP3421 and
displays the ADC conversion values. The PICkit Serial Analyzer links between the GUI
and the MCP3421 SOT23-6 Evaluation Board, and provides the 1°C communication
PC to the MCP3421 SOT23-6 Evaluation Board. The user also can use this MCP3421
SOT23-6 Evaluation Board without the PICkit Serial Analyzer by providing the 1°C
communication signal to the SDA and SCL test pads on the board.

This evaluation board has the following interface:

« PICKkit Serial Analyzer (P/N: DV164122) for writing configuration register bits and
reading the conversion data.

Note: The user can use this board without the PICKkit Serial Analyzer as long as
the Vpp, SCL, and SDA are provided to the board. This evaluation board
does not include MCU.

The user can monitor the 1°C communications by connecting an oscilloscope to the
SDA and SCL test pads. Refer to Appendix A. “Schematic and Layouts”.

1.2.1 I2C Address Bits

The I12C device code and address bits of the MCP3421 device on this board are
“1101000". These bits are programmed at the factory during production.

© 2009 Microchip Technology Inc. DS51793A-page 5
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Powr [ AAUSE 0 MCP3421
W, E88885 SOT23-86
g1 RS > Eval board
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FIGURE 1-1:
Board.

Front and Back Views of the MCP3421 SOT23-6 Evaluation
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1.3 GETTING STARTED WITH PICKIT SERIAL ANALYZER

Figure 1-1 shows the MCP3421 SOT23-6 Evaluation Board and Figure 1-2 shows the
Evaluation Board and PICkit Serial Analyzer connection.

The following steps describe how to use them together:

1. Connect the MCP3421 SOT23-6 Evaluation Board’s J1 pin socket to the PICKit
Serial Analyzer as shown in Figure 1-2.

2. Connect the oscilloscope probes to SCL and SDA test pins (optional).

3. Vpp selection: You can use the Vpp from the PICKkit Serial Analyzer or use your
own external Vpp. You can select the Vpp path using the JP1 connector:

(a) Connect JP1, if using Vpp from PICKit Serial Analyzer,
(b) Disconnect JP1 and apply Vpp at Vpp pin, if you are using external Vpp.

Note: If you are using external Vpp, connect the external Vpp at Vpp pad). I

4. Connect Vpp, if external Vpp is used.

Note: Do not connect Vpp if you are using Vpp from the PICKkit Serial Analyzer.
The PICkit Serial Analyzer provides the Vpp automatically if it is connected
to PC.

5. LED D1 turns on when Vpp is applied.

Note: Ifthe Vpp is provided from the PICkit Serial Analyzer, then the LED may not
be turned on until you execute a command. See Section 1.3.2.1 “Creating
a Script File for Configuration Byte Writing” for executing the 1’c
command.

6. Connecting analog inputs: If you need to measure single-ended input, connect
the unused pin (example, V|y-) to Vgs.

7. Use the PICKit Serial Analyzer PC GUI to send 12C write and read commands.
See Section 1.3.2.1 “Creating a Script File for Configuration Byte Writing”.

8. Execute the PICkit Serial Analyzer Script file and obtain the ADC conversion

results. The conversion results appear on the PICkit Serial Analyzer PC GUI. You
can also observe the conversion results using the oscilloscope.

CAUTION

The analog input pin has ESD diodes. Certain input conditions can damage the
device. Please pay attention to the following conditions:

(a) Do not apply input greater than the input range specified by the MCP3421
data sheet.

(b) Apply input signal after Vpp is powered-up.

© 2009 Microchip Technology Inc. DS51793A-page 7
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Personal Computer

USB Cable

Connected between the
PICKkit Serial Analyzer
and Personal Computer

PICKkit Serial Analyzer

\\

Sensor Input
Connectors

MCP3421 Evaluation Board

FIGURE 1-2: MCP3421 SOT23-6 Evaluation Board with the PICKit Serial Analyzer.
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131 PICkit Serial Analyzer PC Software Set-Up for the MCP3421
SOT23-6 Evaluation Board

The following steps describe how to set up and use the PICkit Serial Analyzer PC
Graphic User Interface (GUI) to write the configuration bits of the MCP3421 on the
Evaluation Board and read the ADC conversion results.

1. Install the PICKkit Serial Analyzer software onto your personal computer (PC).
2. Connect the USB cable between the PICkit Serial Analyzer and your PC.

3. Runthe PICKit Serial PC Software. The following graphic user interface (GUI) will
appear. Click the Next button and follow the instructions.

Configuration Wizard E

= Welcome To The
= PICkit Serial Analyzer
Configuration Wizard

.'3'.1:.:."

L 1
]
£
B
E

o b el =: The following steps will guide vou through the
R o setup af the PICkit Senial Analyzer.

| Mext = | Cancel

FIGURE 1-3: PICKkit Serial Analyzer Configuration Wizard Welcome Window.

4. Select the 12C Master option as communication mode, and click the Next button.

Configuration Wizard E

Communication Mode - Page 1 of 4

Chooze which mode of communication you wizh to uze.

f* |12C Master
" SPI Master
7 USART fsync
" USART Sync Master
< Back Mest > Cancel
FIGURE 1-4: Step 1 - Communication Mode Selection.

© 2009 Microchip Technology Inc. DS51793A-page 9
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5. Select 100 kHz or 400 kHz. Either one will be fine. Click the Next button.

Configuration Wizard E

Communication Speed - Page 2 of 4
Select your [2C communication zpeed

Communication speed may alzo be
I 100kHz  adjusted by using the 'Configure
¥ 400 kHz hMode' page from the 'PICkIt Serial
Analyzer menu dropdowen after
completing the Configuration
Wfizard.

¢ Back Memt > Cancel

FIGURE 1-5: Step 2 - 12C Communication Speed Window.

Note: The MCP3421 device supports the 12C bus data rate up to 3.4 MHz, but the
current version of the PICKkit Serial Analyzer supports the 1°C bus data rate

up to 400 kHz only.

6. Select No on Enable Pull-ups, and click the Next button.

Note: The MCP3421 SOT23-6 Evaluation Board has its own pull-up resistors,
therefore, you don't need additional pull-up resistors from the PICkit Serial

Analyzer.

Configuration Wizard E

Device Pullups - Page 3 of 4

Do pou need to enable pullups for pour device?

Enable Pullupz
" Yez 1+ Mo

< Back Ment » Cancel

FIGURE 1-6: Step 3 - Device Pullups Window.

DS51793A-page 10
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7. Selectthe Vpp voltage of the MCP3421 SOT23-6 Evaluation Board and click the
Next button.

Case 1: When you use Vpp from the PICkit Serial Analyzer:

If you choose PICKit Serial will power my device and 5 Volt as shown below,
the MCP3421 SOT23-6 Evaluation Board is powered by the 5V DC from the
PICKkit™ Serial Analyzer through the JP1 jumper. In this case, make sure that the
JP1 jumper on the MCP3421 SOT23-6 Evaluation Board is connected.

Case 2: When you use your own Vpp:

You can also provide your own Vpp voltage by applying a Vpp voltage at the Vpp
test point on the board. In this case, make sure the JP1 jumper is disconnected.

Configuration Wizard E

Yoltage Source - Page 4 of 4
Does PICKR Senial need to power your device?

Yoltage

v FICkit Serial wil

power my device . o
IF PICKit Serial will poweer wour

f# 5%l device, select the checkbox to
™ Other the left, then determine pour
voltage.

g0

¢ Back Memt > Cancel

FIGURE 1-7: Step 4 - Voltage Source Selection Window.
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8. Click the OK button. You have made all of the PICkit Serial Analyzer configura-
tion set-ups. You are now ready to program the MCP3421 SOT23-6 Evaluation

Board using the PICkit Serial Analyzer.

Configuration Wizard E

You're Done!

Presz '0FK' to complete the Configuration ‘wizard.

[ Do not show this wizard on startup again

“wiizard may be acceszzed anytime from
menu dropdown PICK Senal Analpzer -»
Run Configuration ‘wizard.

Ok

FIGURE 1-8: Configuration Wizard - Finishing Step.
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1.3.2 Creating Script Files

In order to make a communication between the PICkit Serial Analyzer and the
MCP3421 SOT23-6 Evaluation Board, a script file is needed. The following procedure
shows how to create script files and how to use them.

* Select Communication ----- > Script ---> Script Builder

1 P|Ckit Serial - 12 Master Mode E
Cammunications | PICKE Serial Analyzer  DemaBoards  Lser Defined Templates  View  Window  Help

Basic Operations sic Operations | Reset l2LM

Sarpt Srip Buider I stos

- [ Update
Seript Execute I Executive Emar

W Communicztion Eror
I I2€ Eror

1 | j
Transactions EitRate: 100.0kHz

Source Waltage: 4.4
[rata Line Waltage: 484
Clock Line oltage: 4.7

File » Edit v Clear

02/13/2007 4:59:14 MM

Welcome to PICkit Serial version 2.0.1.0

Found PICkits.d11 - Ver: 1,3.0.0

Found PICkit Serial Analyzer - FW Ver: 0x0108
1158 cantral block updated with preference data.

Basic WView Set,

FIGURE 1-9: Creating a Script File with Script Builder.

© 2009 Microchip Technology Inc. DS51793A-page 13



MCP3421 SOT23-6 Evaluation Board User’'s Guide

1321

1.

Modifying the Script Details parameters:

1.
2.

CREATING A SCRIPT FILE FOR CONFIGURATION BYTE WRITING

Click on WriteBlockAddrA8 in “Example 1°C Scripts” column.
 This will result in filling in the spaces under the Script Detail column. Now you

can modify the Script Detail column parameters by clicking with the right mouse
button.

Under the Script Detail box, select the item in the parameter box.

Right click the mouse button and an option box appears to the right of your
selection, displaying the options that are available for the parameter selected.

Select the desired options (delete or insert the parameter box).
Keep the parameters in the same order as shown below.

idl PICkit Sarial - 13C Master Mode

Communications

Wigw: Basic

ScptMame

PICkt Serial Snalyzer

Communications: Basic Operations

Script Builder - _;

MCP3421_irite

Save Script

Execute Scnpt

Clear Seript

Del User Scripts

Show Array

Demo Boards

R ecat

Example [2C Scnpts
Readtddral

II'|'I'|'Ilr "ﬁ"ll'l |j |j f.":"u Ei
WhriteB lockAdditB
ReadBlockAdds?

/—V

1. To change value:

e Click this box and
type a new value.

2. To delete or insert box:

e Choose the box and right
click the mouse button for
" options available.

3. Make sure the listed
parameters in “Script Detail”
are in the exact order
as shown here.

User Defined Templates

Ccnpt Detal

|2CSTART

I2CWRTEYT

0z

(i

£l

12C5T0P

| »

Wiew  Window  Help

User I2C Scpts

MC=3421 Wirke
MCP3421_Read_000

FIGURE 1-10:

Modifying Parameters in the Script Builder Window.

DS51793A-page 14
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5. Change the parameter value.

Script Detail

I2CSTART *

I2CWRTBYT *

02 | - > This means there are two bytes to send

po | - > 1st Write Byte: Address byte with W/R bit = 1101-0000
9C | - > 2nd Write Byte: 1001-1100

I2CSTOP *

Note: All 6 parameters above must be listed in the same order as shown here.
The parameter above with * are not modifiable. Address bits
(A2, A1, A0) = (0,0,0) for this evaluation board. See the MCP3421 Data
Sheet for more information on address bit selection.

© 2009 Microchip Technology Inc. DS51793A-page 15
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il PICKit Serial - 12C Master Mode

Communicakions  PICkit Serial Analyzer  Demo Boards  User Defined Templates  YWiew  Window  Help

View: Basic | Communications: Basic Operations | Resek

Script Builder = X

Example 12C Scripts Script Dretail I1zer [2C Scripts
Script M ame Fead&ddras |I2EST.-’-‘-.F|T il MCP3421 ‘wiite
7 Wwiitedddras MCP3421_Read_000
[EFEBTE WiteBlnckAddi [2CWRTEYT -
i FeadBlockAddriad |EI2
Cave Script | ®
0o »
Execute Script | T "
. Clear Script | l2csTOP _
Address Byte x
Del Uzer Scripts | x
q A x
Show Array | Configuration Byte

|
|
|
(90) | x
|
|
|
|

(s JMwW_J[oz2] o] [eC] [P_]
(s_1[r_]

Note that the “9C” in the configuration byte selects the following options:
- Conversion Mode: Continuous Conversion

- Bit Resolution: 18 bits
- Gain Selection: 1x

FIGURE 1-11: Script File Example for the 12C Write Command.
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1.3.2.2 SAVING THE SCRIPT FILE AND PROGRAMMING THE
CONFIGURATION REGISTER

1. Change the 2nd and 3rd data bytes you want in the Script Detail.

2. Type in any script name (i.e., MCP3421_ Write) in the space below the Script
Name menu.

3. Click the Save Script button.
4. Click the Execute Script button.

Note: At this point, the PICkit Serial transmits the 12C Write Command to the
MCP3421 device. The saved file name will appear in Users 12C Scripts
column and can be re-used any time by selecting the file name.

5. You can also see the SCL and SDA waveforms using the oscilloscope.

Note: When you click on the “Execute Script” menu, the “Busy” LED on the PICKkit
Serial Analyzer will momentarily turn on and then turn off. If the LED
remains ON, a communications problem has occurred. Remove the PICkit
Serial Analyzer from your computer and re-check the parameter values
including the order of parameters under the “Script Detail” column. Try
again until the “Busy” LED goes OFF immediately after executing the write
command.

T T === T LTI

Write Command with Address bits Configuration Bits

FIGURE 1-12: I2C Write Command Waveforms for the MCP3421.
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1.3.3 Reading the Conversion Data using the PICkit™ Serial Analyzer

You can read back the conversion data by following the next steps.

1.3.3.1 CREATING A SCRIPT FILE TO READ THE CONVERSION DATA

1. Click on ReadAddrA8 in “Example 12C Scripts” column.

* This will result in filling in the spaces under the Script Detail column. Now you
can modify the parameter boxes (delete or insert) in the Script Detail column with
options. The list of options will appear if you click the right mouse button at the
parameter box. You can delete the parameter box or add a new one.

« Make sure you have the “Script Detail” parameters are listed in order as
follows:

Script Detail

[2CSTART
I2CWRTBYT
o1 | - > This means there is one byte for address
[ > Address byte with W/R bit = 1101-0001
I2CRDBYTNLB | *

5 |- > 5 bytes to read

12CSTOP *

Note: All 7 parameters above must be listed in the same order as shown here.
The parameters above with * are not modifiable. Address bits
(A2, A1, AO) = (0,0,0) for the MCP3421 in this evaluation board. See the
MCP3421 Data Sheet for more information on address bit selection.

DS51793A-page 18 © 2009 Microchip Technology Inc.
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18 P|Ckit Serial - 120 Master Made

Communications  PICkit Serial Analyeer  DemoBoards  User Defined Templakes  Wiew  ‘Window — Help

Wew: Basic | Communicatdons: B3si Cperations | Resed

Scripl Ruilder '. H
Example 120 Scripks Soripk O etail I1zer I2C Scripks
Script Name Meoadtddidl Z0START o WCP212| Read

MCF3421_Fead ribed i e e
ﬁ riteB loekAddu 2 120WRTEYT

a ReadBlockAddas ]
Save Scipt *

(] x
Execute Scrpt IW
Clear Sciipt 5 *
IZC5TOP
el User Scripts - ®
Requesting l—"
Show Anay | 5 Bytes I—"

Fie « Edit ~ Jdear

FIGURE 1-13: Script File Sample to Read Conversion Data.
2. Type in any script name (i.e., MCP3421_ Read) in the space below the Script
Name menu.

3. Click Save Script button.
4. Click Execute Script button.

Note: Atthis point, the PICkit™ Serial transmits the I°C Read Command to the
MCP3421 device. The saved file name will appear in Users 12C Scripts
column and can be re-used any time by selecting the file name.

5. You can also see the SCL and SDA waveforms using the oscilloscope.

Note: When you click on the “Execute Script” menu, the “Busy” LED on the PICKkit
Serial Analyzer will momentarily turn on and then turn off. If the LED
remains ON, a communications problem has occurred. Remove the PICkit
Serial Analyzer from your computer and re-check the parameter values
including the order of parameters under the “Script Detail” column. Try
again until the “Busy” LED goes OFF immediately after executing the read
command.
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1 PICkit Serial - 12C Master Mode

Communications  PICKE Serial Analyzer  Demo Boards  User Defined Templates  Wiew  Window  Help

View: Basic | Communications: Basic Operations | Reset

Script Builder o x

Example |2C Scripts Script Detail zer 12C Scriptz
Script Mame Readtddrad il FACF 3427 wiite
MCP3421_Read_00p | | Writehddisd J2CSTART MCP3421 Read 000
- - WiriteBlockaddisg |I2E"-.-'-.-’HTBYT
i FeadBlockaddisd |EI1
Save Scrpt | ®
] D1 x
Execute Scnpt | |I2EHDB'T’TNLB
Clear Scrnipt | |5 i

I2C5TOP

Requesting
5 Bytes

Del User Scripts |

Show Array |

eI _J[01] 1] [RM][O5] [P_]‘/Geading ConversioD
[5_][01][01] [AD] [1€] [9€] [P_] oo

A A

L 5th Byte: Repeated Byte for Configuration byte
(note that RDY bit returned to “1” after 4th byte)

4th byte: Configuration Byte (note that RDYbit is “0”)
3rd byte: Data Byte

—— 2nd byte: Data Byte

— 1st byte: Data Byte

Results:

Output code: 101AD in hex (= 65965 in decimal)

Output Voltage: 65865 x 15.625 mV (LSB) = 1.0307 V with PGA =1

PGA
Note:

* 1 LSB with 18 bit resolution option: 15.625 pV

FIGURE 1-14: Reading Conversion Results: Note that the single ended Input = 1.0307V is applied at
Ch.1. The reading indicates the measured value is 1.0307V. See Figure 1-15 for waveforms.
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|r !r r .Ir |".Ir |r r r II' Ir |I' !‘l |r |r ||' |r

R R — ———— . R

. A A A

Data Bytes = 0101AD (hex)

(a) Read command and outputs. The 3 data bytes are zoomed in for better clarity.

5th Byte

"=m

Configuration Byte and Repeated Configuration Byte

(b) Read command and outputs. The last two data bytes are zoomed in for better clarity.

FIGURE 1-15: Read Command and Data on I2C bus. Note the RDY bit in 4th byte is “0". This means
the conversion data just read is the latest conversion data. After the RDY bit is read out at the 4th byte, the
RDY bit becomes “1” in the 5th byte (repeated byte). This means the device is now in the process of a new
conversion and the latest conversion result is not ready yet.
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NOTES:
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@ MCP3421 SOT23-6 EVALUATION
MICROCHIP BOARD USER’S GUIDE

Appendix A. Schematic and Layouts

A.1 INTRODUCTION
This appendix contains the following schematics and layouts for the MCP3421
SOT23-6 Evaluation Board:
» Board — Schematic
» Board — Top Layer
« Board — Top Metal Layer
« Board — Bottom Layer
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BOARD - SCHEMATIC

A.2

d | 9) g v
I JO | I®dYS HOS'Z¥ ¥2100—5@| dwbu3|l4
DIoIDY T :Aq_UMDIQ 80/82/L :21Q
997 ognoy :4esuibul n_IUOEU—E
‘ W
| 7C100—C0L ) oz oxXL¥aH L
‘P9 IPA3 9—-€Z10S LZYedON 818158 W B
Jamod
—  2udr
M _‘D/v
4nol dnl'e dN& MS< | dNa %G
I_\ dNd
1 e
v vas 10s ¢
S JaAv  SsAY Z
9 =NIA  +NIA T
L ZYSdON
N
Iej o} © O o o
‘Sd1 |PuUoI}PPD N9 vas ddA U +UIA 108 adA
20/10/2 sbuby) ynou) JouN| ¢ ¥dl /dl £dl ¢dl ldl  &dlL  9dl
90/2L/01 ubisaq |pi3iu| L
a10Q S8JON UOISINGY A3
d | 9) g v

© 2009 Microchip Technology Inc.

DS51793A-page 24



Schematic and Layouts

A.3 BOARD -TOP LAYER

Power 00000 1 MCP3421
BE z283s% sSOT23-6
D1 RS Eval board
BN VDD @"P1 102-00124
o SCL
B Vin U1 M C2 ]
ﬂ MMt
Bl Vin+ SDA I
—
B GND 244 GND
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A.4 BOARD - TOP METAL LAYER

Power J1. MCP3421
SO0T23-6
Eval board
102—00124
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A.5

BOARD - BOTTOM METAL LAYER
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NOTES:
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MICROCHIP

Appendix B. Bill Of Materials (BOM)

TABLE B-1: BILL OF MATERIALS
Qty Reference Description Manufacturer Part Number
1 C1l CAP .1UF 25V CERAMIC X7R Panasonic® - ECG ECJ-2VB1E104K
0805
1 Cc2 CAP CERAMIC 10UF 6.3V X5R Panasonic - ECG ECJ-2FB0J106K
0805
1 D1 LED RED ORANGE CLEAR 0805 |LITE-ON INC LTST-C170EKT
SMD
1 J1 CONN HEADER 6POS .100 R/A Molex/Waldom® Electronics | 22-05-2061
TIN Corp
1 PCB RoHS Compliant Bare PCB, — 104-00124
MCP3421EV
2 R1,R3 RES 4.99K OHM 1/8W 1% 0805 Panasonic - ECG ERJ-6ENF4991V
SMD
R2,R4 DO NOT POPULATE — —
R5 RES 470 OHM 1/8W 5% 0805 SMD | Panasonic - ECG ERJ-6GEYJ471V
Ul 18-Bit Analog-to-Digital Converter | Microchip Technology Inc. MCP3421A0T-E/OT
with 12C Interface and On-Board
Reference
7 VDD Vin+ Vin- | TEST POINT PC COMPACT SMT | Keystone Electronics® 5016
GND SCL SDA
VDD
Note: The components listed in this Bill of Materials are representative of the PCB assembly. The

released BOM used in manufacturing uses all RoHS-compliant components.

© 2009 Microchip Technology Inc.
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